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About PrintSmith Tracker  

PrintSmith® Tracker provides real-time shop floor data collection and job costing. This 
add-on to PrintSmith tracks the time jobs take as they go through the production process. 
Tracker also calculates the costs associated with the production of a job. Using the time 
and cost data collected by Tracker, you can improve efficiency or change your pricing to 
reflect your costs more accurately.  

Tracker has the following features: 

 Lets you filter what each department or employee sees. For example, employees 
on the shop floor typically see just the processes and completion status of their 
own jobs. 

 Includes a “release to production” process to manage the flow of work through 
your shop. 

 Lets employees pause each step in the production process if necessary and 
restart it at the point left off. Time is tracked for each step, including setup time 
and washup time, as well as the process as a whole.  

 Lets employees review job tickets and other instructions (such as cutting 
diagrams) as they work on tasks. 

 Lets service people, salespeople, and managers know exactly where jobs are 
and who is working on them so they can respond to customer inquiries 
immediately. In addition, production and employee reports help managers 
analyze the data collected by Tracker. (Additional reports can be generated with 
Report Writer, another PrintSmith add-on.) 

 Gives you accurate information for job costing and for comparing estimated to 
actual times by automatically recording elapsed times. Job costing data is also 
automatically updated on invoices. 

 Supports the use of bar code readers (available from EFI) for scanning 
information at various production locations.  

 Allows tracking across multiple facilities. 

 Is integrated with PrintSmith Scheduler, although you do not have to own 
Scheduler to use Tracker. 
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About this Guide 

This guide describes how to set up and use PrintSmith Tracker. The guide assumes that 
PrintSmith is already installed and configured and that you are familiar with its features. 

Additional Sources 

For information about See 

Installing PrintSmith PrintSmith Installation and Upgrade Guide 

Setting up and using 
PrintSmith 

PrintSmith Setup Guide and PrintSmith Reference Guide 

Credit card processing in 
PrintSmith 

PrintSmith Secure Credit Card Processing 
Implementation Guide 

PrintSmith Scheduler PrintSmith Scheduler User Guide 

PrintSmith Site PrintSmith Site Administrator Guide 
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Customer Support 

You can contact PrintSmith Customer Support in any of the following ways.  

Phone 

North America 

888.731.2618 
480.538.5800 
Monday - Friday 7 A.M. - 5 P.M. US Mountain Standard Time 

UK 

0800 783 2737 
Monday - Friday 8 A.M. - 5 P.M. UK Time 

EMEA 

+49 2102 745 4500 
Monday - Friday 9 A.M. - 6 P.M. Central European Time 

Fax 

480.538.5804 (North America) 

E-Mail 

North America 

Printsmith.service@efi.com 

EMEA 

Europe_support@efi.com 

Mail 

EFI, 17250 N. Hartford Drive, Scottsdale, AZ 85255, U.S.A. 

 

 

mailto:Printsmith.service@efi.com
mailto:Europe_support@efi.com
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Overview of Setup 

Before you can start using PrintSmith Tracker, you must complete some initial setup 
tasks.  

Basic setup includes: 

 Activating Tracker in PrintSmith. 

 Entering data in Tracker-related tables.  

 Entering Tracker-related information in your press, copier/digital, and charge 
definitions. 

 Setting up those employees who will be using Tracker. 

Additional setup to take full advantage of Tracker includes: 

 Setting up costing information. 

 Defining routings (only if you are not using PrintSmith Scheduler). 

You can do the additional setup later; costing and routings are not needed to use Tracker. 

Note EFI recommends a phased approach to implementing PrintSmith Tracker. With 
the basic setup completed, you can start using Tracker and familiarize yourself 
with its features. As you become comfortable with Tracker features and workflow, 
you can set up costing and routings and take full advantage of Tracker. 

Activating PrintSmith Tracker  

To activate Tracker, you must enter the activation code supplied by EFI in your PrintSmith 
preferences. Tracker commands and features then become available in PrintSmith. 

1. In PrintSmith, select Admin > Preferences. The Preferences window opens. 

2. In the navigation pane on the left, click System and then click Product 
Activation. 

 

3. In the Tracker data collection field, enter your activation code. 

4. Click OK and then click Close. 
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Setting Up Tracker-Related Tables 

Several PrintSmith tables provide information that is used by Tracker. Use Table Editor 
(Admin > Table Editor) to enter information in these tables. For information about using 
Table Editor, see the PrintSmith Reference Guide. 

Production Copiers table 

The Production Copiers table contains the names of your copiers, for example, Docutech 
or Canon CLC 5000. (These should be the manufacturer’s names for the copiers.) You 
then select a copier from this table for the Machine Name field in the Copier/Digital 
Definitions window (see page 17). Copier names are also used in employee production 
filters to determine which jobs are displayed in the Tracker Console. (For information 
about production filters, see page 26.) 

Production Dates table 

The Production Dates table includes the completion categories that you can use when 
defining steps in routings. (Routings are an optional feature in Tracker, and do not apply if 
you use PrintSmith Scheduler.) When a completion date is associated with a step in a 
routing, once the step is completed, the date and time of completion are automatically 
provided by Tracker. (For information about routings, see page 38.) 

Production Exceptions table 

The Production Exceptions table contains reasons for problems during the production 
process, for example, static in paper or bad plate. The types of reasons you enter in this 
table are up to you, but should provide a standard way for production staff to explain 
problems without requiring them to type a note. The reasons in this table can then be 
selected by employees in the Exception code field in the Stop Tracker Step window 
(page 72) and Tracker Details window (page 76).  

Production Facilities table 

The Production Facilities table contains the names of the physical locations/buildings 
where your production machinery is run and operated. The default facility is set as In 
House, but you can edit this name to match your conventions. If all of your jobs are 
processed in one building, you do not need to enter anything in the Production Facilities 
table. 

Production Locations table 

The Production Locations table contains the names of stages in the overall production 
process, for example, Design, Running - Print, or Boxing. The names of the locations 
are up to you, and are typically based on the terminology used in your shop. For example, 
when a job is in the printing stage, you could call that production location Press, On 
Press, or In Printing. When a job is being copied, you could call that production location 
Copy, Being Copied, or In Copying.  
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Production Presses table 

The Production Presses table contains the names of your presses, for example, Komori 6 
or AB Dick. (These should be the manufacturer’s names for the presses.) You then select 
a press from this table for the Machine Name field in the Press Definitions window (see 
page 15). This machine name is displayed in the time bar in the Tracker Console, is 
included on the job ticket, and can be used to sort the PrintSmith Work in Progress report. 
Press names are also used in employee production filters to determine which jobs are 
displayed in the Tracker Console. (For information about production filters, see page 26.) 

Production Priority table 

The Production Priority table includes the levels of important for jobs, for example, 
Normal, Priority, or Red. The priorities you define are up to you; they should match the 
terminology used at your shop. Production priorities can be assigned to a job in the tracker 
production window (see “Releasing jobs to production” on page 68). 

Production Stations table 

The Production Stations table includes names for the computers where PrintSmith is 
running, for example, Press Station One, Supervisor Station, Folding Station, or 
Shipping Station. These names are up to you, but they should give an idea of where 
data collection is taking place so filters can be defined to display just the jobs that are in 
the vicinity of a production station.   

If You Plan to Scan Bar Codes 

You may find it convenient to scan bar codes as you record the progress of a job through 
production. If you want to do so, you must purchase a bar code reader from EFI to use 
with PrintSmith. This purchase includes Carolina Code 39 bar code fonts that you will 
need to print your bar codes.  

Note Only the bar code reader available from EFI is supported in PrintSmith. 

After you purchase the bar code reader from EFI: 

1. Install the Carolina Code 39 bar code fonts on every workstation where you plan 
to print documents with bar codes on them, for example, job tickets or employee 
bar codes.  

2. In PrintSmith, select Admin > Preferences > Estimator > Job Ticket. 
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3. Select the Add Tracking Bar Codes check box. 

4. Click Set Bar Code Font and select the Carolina Code 39 bar code fonts you 
installed. 

5. Click Print Bar Codes to print a sheet with the bar codes for your production 
locations (as defined in the Production Locations table; see page 13). 

Adding Tracker Information to Pricing Definitions 

After you enter information in the Tracker related tables, you must select some of that 
information in your press, copier/digital, and charge definitions so it is available to Tracker. 
You must also ensure costing is defined so that Tracker can use this information. 

Press definitions 

For each press definition, make sure a machine name and production location are 
selected. Tracker can also use the washup minutes specified for a press. (For details of 
setting up press definitions, see the PrintSmith Reference Guide.) 

1. Select Pricing > Press Definitions. The Press Definitions window opens. 

2. Select a press in the list. 

3. In the Machine Name field, select the name of the press (as defined in the 
Production Presses table), for example, AB Dick. 

4. In the Production Location field, select the process associated with the press 
(as defined in the Production Locations table), for example, Running – Print. 

5. Make sure a labor rate is defined so Tracker can track costs. 
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6. In the Washup Minutes field, enter the time per wash. 

7. Click Change. 

8. Repeat steps 2 through 7 for all your press definitions. 
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Copier/Digital definitions 

For each copier/digital definition, make sure a machine name and production location are 
selected and costing information is provided. (For details of setting up copier/digital 
definitions, see the PrintSmith Reference Guide.) 

1. Select Pricing > Copier/Digital Definitions. The Copier/Digital Definitions 
window opens. 

 

2. Select a copier in the list.  

3. In the Machine Name field, select the name of the copier (as defined in the 
Production Copiers table), for example, Canon CLC 5000. 

Costing 
information. 
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4. In the Production Location field, select the process associated with the copier 
(as defined in the Production Locations table), for example, Running – Color 
Copy. 

5. Provide costing information for the copier. In particular, enter the hourly rate for 
the equipment in the Hourly Costing Rate field since Tracker uses this 
information. 

6. Click Change. 

7. Repeat steps 2 through 6 for all your copier definitions. 

Charge definitions 

Not all charge definitions require tracking. If a charge is not part of the production workflow 
(for example, postage or letterhead boxes), you can exclude the charge from the workflow 
so that it is not displayed in Tracker.  

For charges that are part of the production workflow, you must select a production 
location. If necessary, you can also indicate that pre-production work needs to take place 
before the job is released to production. For example, design may be required before a job 
can be produced. 

To take full advantage of Tracker, also provide costing information for your charges, as 
described in “Defining Estimated Costs for Charges” on page 19. (You can do this at a 
later point if you prefer.) 

1. Select Pricing > Charge Definitions. The Charge Definitions window opens. 

 

2. Select a charge in the navigation pane on the left.  

3. If the charge is part of the production process,  

a. In the Production Location field, select the process associated with the 
charge (as defined in the Production Locations table), for example, 
Prepress. 
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b. If work is required before the job is released to production, select the 
Tracker Pre-Production check box. Design charges typically have this 
check box selected. 

Caution Use this feature with care. When a job is released to production, it 
is “locked” so changes cannot be made to it while it is in production. 
When work is done before a job is released to production, there is 
nothing to prevent someone else from changing the charge or job 
while the work is taking place. 

c. Define estimated costs for the charge as described in the section that 
follows. 

4. If the charge is not part of the production process and should not be displayed in 
Tracker, select the Excluded from workflow check box. For example, postage 
or boxes would be excluded. 

5. Click File. 

6. Repeat steps 2 through 5 for all your charge definitions. 

Defining Estimated Costs for Charges  

To take full advantage of Tracker you must define costs for those charges that are not 
excluded from the production process. Tracker can then compare these estimated costs to 
the actual costs of producing a job. When you first defined your charges, you may have 
already specified costs for them. If not, do so now. 

The section that follows summarizes the ways you can define costs. For more information 
about costing, see PrintSmith Reference Guide. 

To define costs for charges 

1. Select a charge in the Charge Definitions window. 

Note  If no costing was defined for a charge,  is displayed to the left of the 
charge name in the left pane, and the costing method is set to No Cost. 

 

No costing is 
defined. 
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2. Click Costing (on the toolbar of the Charge Definitions window). A window opens 
with the name of the charge in the title bar. 

 

3. In the Costing Method field, select one of the following: 

 No Cost if the charge does not incur costs, for example, a shop minimum.  

 100% Cost if the charge (for example, postage) should be passed on in full. 

 Unit Cost if the charge (for example, ink) is typically defined by unit or if the 
charge has no internal labor associated with it, but has a cost with an 
outside vendor (for lamination, for example). You can either specify a unit 
cost or define a rate table so the cost varies according to quantity. 

 Time and Materials if the charge involves labor and possibly material, for 
example, making plates or stripping. When this costing method is used for a 
charge, you can use Tracker to compare estimated to actual times and 
costs.  

4. If you selected Unit Cost, either provide a setup and unit cost or define a rate 
table. 
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5. If you selected Time and Materials, enter the fixed or unit material costs, labor 
rate, setup time, and/or pieces per hour as applicable. You can also assign a 
speed table if speed is a factor in costing. 

Managing Employees 

As part of Tracker setup, you must define the employees who will be using Tracker, 
including managers or supervisors. As part of this process, you specify what employees 
can see or do when using Tracker, as well as configure time periods and clock options. 
This setup is performed with Employee Manager 

Using Employee Manager 

Employee Manager lets you manage various aspects of the employees who use Tracker 
as well as lets employees clock in and out of Tracker.  

To open Employee Manager, select Admin > Employee Manager in PrintSmith. 
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Employee Manager includes the following features: 

 Clock In/Out: for clocking in and out so that employees’ time is recorded.  Only 
employees who are clocked in can use the Tracker Console. For information, see 
“Clocking In and Out” on page 57. 

 Employees: for defining those employees who use Tracker (see below).   

 Clock Options: for setting options such as the message to be displayed at clock 
in/out for individual employees. For information, see “Setting Clock Options” on 
page 32. 

 Time periods – For defining pay periods. For information, see “Defining a Pay 
Period for Time Cards” on page 34. 

 Edit time cards – For reviewing and changing employee time cards. For 
information, see page 49.  

 Reports – For running employee time reports. For information, see page 52. 

 Exports – For exporting employee time information so it can be imported into 
another system like a payroll system. For information, see page 53. 

Defining employees 

Before your production staff can use Tracker, they must be defined as employees. An 
employee definition (or profile) includes general information about an employee as well as 
settings that control what the employee can see and do while using Tracker.  

Note Employee definitions are required only for production staff whose time needs to 
be tracked or for supervisors who need to work with Tracker.  

General procedure 

1. In Employee Manager, click Employees. A window opens listing existing 
employees (if any).  

2. Click Cancel. The Employee window opens.  

Tip  Once the Employee window is open, you can add an employee by 
clicking New. 

 

3. Complete the Settings tab. See page 23.  

4. Complete the Personal tab. See page 24.  

5. Complete the Production Filter tab. See page 26. 
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6. Click File. 

7. Repeat these steps for each employee you need to define. 

Entering employee settings 

Use the Settings tab to provide contact information for an employee, as well as enter the 
employee’s social security number. Only the first and last name are required to use 
Tracker; the other fields are optional and just there for reference or for use with another 
system such as a payroll system. 

1. On the Settings tab, enter information in the First and Last fields. 

 

2. (Optional) Complete other fields as necessary for reference purposes or for use 
with an external system. 

Note You can use the Export Code field to enter an ID (up to 19 characters) 
from a third-party system to help you match exported employee data 
(see page 53) with records in that system. 

3. Click Save. (If you click File instead of Save, the Employee window closes.) 

  

Only these 
fields are 
required. 

ID is 
assigned 
after you 
save the 

employee. 
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Entering personal information for an employee 

Use the Personal tab in the Employee Window to define several security settings for an 
employee. For example, you can control what the employee sees and can do, as well as 
require the use of a PIN (personal identification number) or magnetic card with a bar code 
to gain access to the Tracker Console. 

Tip If you are creating an employee definition for yourself or another supervisor, 
select the Allow to override costs and Allow to modify production settings 
check boxes and clear the Hide costing amount, Hide items not released to 
production, and Hide estimated time in Tracker Console check boxes. 

 

1. In the Rate field, enter the employee’s hourly wage. This is required only if you 
want to use this data for reports you produce with PrintSmith Report Writer. 

2. By default, the Status for a new employee is set to Active. Change this to 
Inactive if you do not want the employee to be available in Tracker. For example, 
if employees take a leave of absence or are on vacation, you can mark them as 
Inactive to prevent their names from showing up in the list of employees 
available to work on jobs.  

3. Under Editable Production Options, select or clear the following check boxes: 

Allowed to override costs 

Select this check box if the employee has a supervisory role and you want to 
allow the employee to make changes to the production cost calculations once a 
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job is complete. The employee can then change the actual costs that were 
collected in the Stop Tracker Step window. (For more information about this 
window, see page 72.) 

Hide costing amounts  

Select this check box if for reasons of privacy, accounting, or company policy, 
you do not want the employee to see costs related to labor and stock for a job. 
When this check box is selected, the estimated and actual stock and labor costs 
are not displayed in the Stop Tracker Step window (page 72) and the Tracker 
Details window (page 76). 

Hide items not released to production  

Select this check box if the employee should only see jobs that were released to 
production, not those that are waiting to be released.  

Hide estimated time in Tracker Console 

Select this check box if the employee should not see estimated times in the 
Tracker Console or the Tracker Details window.  

Allow to modify production settings 

Select this check box to let the employee modify production settings in the 
tracker production window, for example, release the job to production or change 
the priority of the job. For information about the tracker production window, see 
“Releasing jobs to production from tracker production window” on page 68. 

Allow Tracker NEXT location to be modified  

If you use routings at your shop, select this check box to let the employee modify 
the next production location in the Stop Tracker Step window (page 72). 
Otherwise, the next location is controlled by the assigned routing definition. 

Auto show Tracker Console at clock in 

Select this check box if the Tracker Console window should open automatically 
when the employee clocks in.  

Auto show My Work Center at clock in 

Select this check box if My Work Center (part of PrintSmith Scheduler) should 
open automatically when the employee clocks in. (For information about My 
Work Center, see the PrintSmith Scheduler User Guide.) 

4. If for security reasons you want the employee to enter a PIN (personal 
identification number) before working in the Tracker Console, under PIN 
Settings, select the Require PIN check box and then enter a number between 
four and nine digits long in the PIN field. (The PIN is not displayed as you enter 
it.) EFI recommends the use of a PIN unless you use magnetic cards as 
described in the next step. 

5. If you want to use magnetic cards with bar codes instead of PINs to control 
access to the Tracker Console, select the Allow authentication with magnetic 
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card check box. You are then asked to swipe the employee’s magnetic card. 
After you do so, click Accept. (The card information is stored in an encrypted 
manner.) The employee can now log into the Tracker Console by swiping the 
magnetic card at the workstation. 

6. Click Save. (If you click File instead of Save, the Employee window closes.) 

Specifying production filters for an employee 

Use the Production Filter tab in the Employee window to control which jobs an employee 
sees in the Tracker Console and to make it easier for employees to find their own jobs. 
For example, if you selected all four Use all… check boxes (such as Use all Pricing 
Methods), the list of active items could be extremely long. Unless employees need to see 
everything, you would typically filter what they see based on the work they perform. 

Tip If you are creating an employee definition for yourself or someone else who is a 
supervisor, you will typically want a view of all items in your department or facility.  

 

1. Under Include, select the type of information from invoices (or estimates) that 
the employee will see. 
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Note  In general, select the Invoices and not the Estimates check box. 
Estimates are included to accommodate those users with an Estimator-
only version of PrintSmith. The rules described for invoices below also 
apply to estimates.  

a. Select the Invoices check box to include invoices in the Tracker Console.  

b. Select the Jobs and/or Invoice Level Charges check boxes.  

Important One of these check boxes must be selected in addition to the 
Invoices check box, or nothing will be displayed in the Tracker 
Console.  

If you select the Jobs check box, the employee will see each job in an 
invoice on the Active Items tab in the Tracker Console. For example, if 
invoice 1803 includes jobs for Letterhead, Envelopes, and Business Cards, 
the jobs are displayed in the Tracker Console as 1803/1 Letterhead, 1803/2 
Envelopes, and 1803/3 Business Cards. If you also want job-level charges 
displayed in the Tracker Console, select the Charges check box. In this 
case, for job 1803/3 Business Cards, the employee might see 1803/3/1 
Plates, 1803/3/2 Ink, and 1803/3/3 Design, depending on other filter settings. 

 

If you select the Invoice Level Charges check box, invoice-level charges 
are included on the Active Items tab in the Tracker Console. 

2. Under Customer wanted by,  

a. Control which jobs the employee will see based on the due date: Due today, 
Due tomorrow, Due this week, Due next (7) days, or Due anytime. (If you 
select Due tomorrow, you also see jobs that are due today.) 
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b. To display jobs that are late (with a due date before today), select the Any 
past due check box. The past due jobs are displayed in addition to jobs that 
meet the “due” criterion. 

Note As a supervisor, you may need to change the Customer Wanted by 
setting according to what is happening in the shop. For example, on 
very busy days you may want this set to Due Today, but otherwise 
have Due Anytime and Any Past Due selected. 

3. If you want the employee to see jobs from the step before the employee’s in the 
production sequence: 

a. Select the Only show checked Production Parents check box. 

 

b. Under Production Parents, click to the left of the location (activity) that 
precedes the employee’s location. (You can select more than one production 
parent.) In the Tracker Console, parent jobs are displayed in blue. 

Notes The production parents that are listed come from the Production 
Locations table, as defined for your shop. For more information 
about this table, see page 13.  

 For a supervisor, clear the production parents unless the supervisor 
is managing a particular department and needs to see the items 
coming to the production staff in that department.  
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4. To control which jobs the employee sees based on pricing method, under 
Pricing methods, click to the left of the pricing method you want the employee 
to see. (You can select more than one pricing method.) For example, an 
employee who works on copiers needs the B&W and Color pricing methods 
selected (in addition to all copiers on which he/she works; see step 7 below). If 
the employee needs to see jobs based on all job pricing methods, select the Use 
all Pricing Methods check box. (This would typically apply only to facility 
managers.) 

 

5. To control what kinds of charges the employee sees, under Charge type, click to 
the left of the charge you want the employee to see. (You can select more than 
one kind of charge.) If the employee needs to see all types of charges, select the 
Use all Charge Types check box. (This would typically apply only to facility 
managers.) 

Note Charge types correspond to the charge commands that are displayed in 
the Charge Definitions window in PrintSmith. The names of these 
commands at your shop may be different from those shown in the figure 
below. 
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6. To control which jobs the employee sees based on presses, under Press click to 
the left of the press on which the employee works. (You can select more than 
one press.) If the employee needs to see jobs on all presses, select the Use all 
Presses check box. (This would typically apply only to facility managers or 
printing foremen.) If the employee does not work on presses, no press selection 
is necessary.  

Note Only presses that are defined in the Production Presses table are 
available for selection.  

 

7. To control which jobs the employee sees based on copiers, under Copier click to 
the left of the copier on which the employee works. (You can select more than 
one copier.) If the employee needs to see jobs on all copiers, select the Use all 
Copiers check box. (This would typically apply only to facility managers or those 
managing copying.) If the employee does not work on copiers, no copier 
selection is necessary.  

Note Only copiers that are defined in the Production Copiers table are 
available for selection.  

 

8. Click File to save the employee. 

Printing an employee bar code 

When you define an employee, PrintSmith automatically assigns the employee a unique 
ID. If you use bar codes at your shop, and require employees to swipe a card to log into 
the Tracker Console, you can print some information about each employee, including the 
bar code that corresponds to the employee’s ID. This bar code can then be placed on the 
employee's badge. 
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To print an employee bar code 

 Click Print in the Employee window or select File > Print.  

The report that is printed includes the employee's name, the PrintSmith employee ID 
number, the employee's status if the employee is currently inactive, and the bar code 
representation of the PrintSmith employee ID number.  

Reviewing and editing employees  

You can review all the information about an employee at any time, as well as change the 
information. Some changes, such as address, have no effect on the way Tracker works, 
but changes to security settings or production filters can change the way the employee 
gains access to the Tracker Console and can affect the type of information that is 
displayed in the Tracker Console. 

To review and edit an employee 

1. Open an employee record in any of these ways: 

 In Employee Manager, click Employees. Double-click an employee in the 
list that is displayed (or click an employee and click Select). The Employee 
window opens. 

 In the Employee window, click Get on the toolbar, and double-click an 
employee in the list that is displayed (or click an employee and click Select). 

 In the Tracker Console, select an employee in the Employee name field and 

click . The Employee window opens. 

2. Make any necessary changes on the Settings, Personal, or Production Filter 
tabs. 

3. To save your changes but leave the Employee window open, click Save. To save 
your changes and close the Employee window, click File. Any changes you 
made on the Production Filter tab are immediately reflected on the Active 
Items tab in the Tracker Console. 

Tip Use Next and Last on the toolbar to move among employee records. 

Deleting employees  

Although you can permanently remove an employee from PrintSmith, this is not always 
the best practice for accounting purposes. Rather than delete an employee who perhaps 
is no longer with your company, EFI recommends that you mark the employee as inactive 
on the Personal tab in the Employee window. This way, the employee is still part of your 
records. (For information about the Personal tab, see “Entering personal information for 
an employee” on page 24.) 

If you do decide to delete an employee, you can do so only if the employee has no active 
items in the Tracker Console. 
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To delete an employee 

1. Open the employee record as described in “Reviewing and editing employees” 
above. 

2. Click Delete on the toolbar. 

3. Click Yes to confirm the deletion. 

Setting Clock Options 

You can establish some settings for individual employees related to clocking in and out. 
For example, you can display a message when the employee clocks in and/or out. The 
window where you set these options also allows managers to see which employees are 
clocked in and out, or on break. 

1. In Employee Manager, click Clock Options. The Clock Options window opens. 
The bottom part of the window lists all the employees and indicates whether an 
employee is clocked in, clocked out, or on break, and whether a message and 
automatic clock-out were defined for the employee. 
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2. Select an employee name in the list at the bottom of the window. 

3. If necessary, under Status, change the status to Active or Inactive. 

4. If you want the employee to be clocked out automatically, under Auto Out, enter 
the time (in the Hour and Minute fields) that you want this to occur. This may be 
useful, for example, if someone is always out doing deliveries at the end of a 
shift. 

5. If you want to display a message when the employee clicks in and/or out, under 
Message, enter the text of the message and then select the Show message at 
clock IN check box and/or the Show message at clock OUT check box. 

6. Click Save to save the clock options. 

Tip  To undo the changes, click Revert. 

  



EFI PrintSmith │ Tracker User Guide 

 

 
Page 34 

Defining a Pay Period for Time Cards 

Employee time cards are grouped by pay period. A period can be custom defined, or can 
be set to weekly, bi-weekly, semi-monthly, or monthly.  

1. In Employee Manager, click Time Periods. The Employee Time Period window 
opens. The Current Period area shows the date range for the currently defined 
period. 

 

2. To define a new period, under Current Period, click Close Current period. 

3. Under Period Type, select Weekly, Bi-Weekly, Semi Monthly, Monthly, or 
Custom.  

4. If you selected Weekly or Bi-Weekly, under Start of Work Week, select the day 
the pay period begins (the default is Monday).  

5. If you selected Custom, in the From and To fields, enter dates in mm/dd/yyyy 
format. 

6. Click OK to save your changes. 
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Management and Administration  
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About Tracker Manager 

With Tracker Manager you can get an overview of all the active items in production based 
on your viewing preferences. If you do not use PrintSmith Scheduler, you can also set up 
routings to help you manage the flow of work through your facility and more effectively 
track actual job times. (Routings are optional.) In addition, Tracker Manager includes tools 
to control the amount of historical data stored and to analyze data through production and 
employee reports.  

When setting up Tracker, you can use Tracker Manager to define routings. Once Tracker 
is being used at your shop to collect data from the shop floor, you use Tracker Manager to 
get an overview of activity at the shop and to run reports to analyze data that was 
collected. 

Setting Tracker Manager Preferences 

Before you start viewing all the active items in production, you should set your preferences 
to control which active items are displayed. 

1. In PrintSmith, select Admin > Tracker Manager. The Tracker Manager window 
opens. 

2. Click the Preference tab. 
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3. To see active items for just one facility, select it in the Facility field. (Facilities are 
defined in the Production Facilities table.)  

To see active items for all facilities, select the Show all facilities check box.   

4. To see only certain stations, click the column to the left of the station you want to 
see. (Stations are defined in the Production Stations table.) A bullet identifies a 
selected station. (To deselect a station, click again.) 

To see all stations, select the Show all stations check box. 

Your preferences are saved automatically and reflected on the Active Items tab. 

Viewing Active Items with Tracker Manager 

The Active Items tab in Tracker Manager shows all the active items that are in production 
based on your Tracker Manager preferences (see above). 

The list of active items includes the following: 

Item A reference number for the job in the format 0000/0/0 where the first part is the 
invoice number, the second is the job or job charge, and the last is the step in the 
process. 

Description The description of the line item from the invoice. 

Time / Qty The total estimated time for the job. 

Duration The amount of time that the job has been in production. 

Who The employee who is working on the item. 

Facility The name of the facility where the step is taking place. 

Station The name of the station where the step is taking place. 

Location The location where the step is taking place. 

Machine The name of the machine where the step is taking place. 

If you are not viewing active items for all facilities and stations, the bottom of the Active 
Items tab indicates how many of the total active items you are viewing. 

To view active items 

1. In PrintSmith, select Admin > Tracker Manager. The Tracker Manager window 
opens.  
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2. By default, items are listed by item number. To sort the items in a different order, 
click the heading of the column by which you want to sort, for example, Location 
or Machine.  

3. To update the list of active items as production data changes on the shop floor, 
click Refresh (in the bottom left corner of the window). 

4. To see more information about estimated versus actual times and costs for any 
item, double-click the item. The Tracker Details window opens. For more 
information about this window, see page 76. 

Defining Routings  

A routing is a set of generic production steps for a job. Each step in a routing has a 
“schedule” associated with it, for example, three days from the ordered day. Although 
routings can be changed during the production process to custom fit any job, they should 
reflect the way standard jobs are processed at your facility. 

Routings are optional; they provide a structured way to use Tracker, but are not required.  

Important If you use PrintSmith Scheduler, do not define routings since you are already 
scheduling jobs. 

Once routings are defined, they can be attached to jobs in the tracker production window 
when releasing the job to production. For information, see “Releasing jobs to production” 
on page 68.  

You use Tracker Manager to define routings. 

Creating a routing 

1. In PrintSmith, select Admin > Tracker Manager. The Tracker Manager window 
opens. 

2. Click the Routing Setup tab. 

3. Click New Routing. The fields on the Routing Setup tab are now available for 
editing.  
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3. In the Route Title field, enter a descriptive name for the routing, for example, 
Prepress/Proof/Production/Bindery, so that it can be easily identified in the 
tracker production window when you assign a routing to a job (see “Releasing 
jobs to production” on page 68). 

4. If you want to save the routing, but do not want it to be available as a selection in 
the tracker production window, select the Disabled check box. 

5. If you want the routing to be displayed as the default routing for all newly created 
jobs, select the Default route for NEW jobs check box. 

6. In the To Here area under Step Details,  

a. Select a Facility for the step. (This field is automatically set to the facility 
specified on the Preference tab, but you can change this. If you did not set 
your preferences yet, do so now as described in “Setting Tracker Manager 
Preferences” on page 36.)  
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b. In the Location field, select the production location for the step (by double-
clicking). For example, the first step in the routing might be Prepress. 
(Locations are defined in the Production Locations table.) 

c. To remove a step temporarily (perhaps because the associated piece of 
equipment is not in service), select the Disabled check box. The routing will 
still be available in the tracker production window for assigning to a job, but 
the step that is disabled will have an X next to it, indicating that the 
equipment associated with the step is not available. 

7. Under When Complete, 

a. Select the Mark INV ready for pick up check box if this is the last step in 
the routing, and the invoice should be marked ready for pick up because the 
job is complete. 

b. Select the Treat as Non-Production step, no cost check box if this is a 
step (such as proofing) that should not be charged to the customer.  

c. In the Completion Category field, select the production “milestone” 
associated with the conclusion of the step. (Not all steps are associated with 
completion categories.) If a step has a completion category, the date and 
time of completion are automatically entered for you. (Completion categories 
are defined in the Production Dates table.) 

8. Under Schedule, select one of the following: 

 Auto schedule days from ordered to schedule the step to start a certain 
number of days from the day the job was ordered. For example, if the job 
was ordered on October 5

th
, and Auto schedule days from ordered is set 

to 5, the step is scheduled to begin on October 10
th

. To set a time for the 
step, select it in the Hour of day field. 

 Auto schedule days from wanted by to schedule the step to start a certain 
number of days from the date the customer requested the job to be 
completed. You can enter either a negative or positive number of days. For 
example, if the customer requested that the job be completed by November 
15

th
, and Auto schedule days from wanted by is set to -7, the step is 

scheduled to begin on November 8
th

. If it is set to 7, the step is scheduled for 
November 22

nd
. If Auto schedule days from wanted by is set to 0, the step 

is scheduled  for November 15
th

. To set a time for the step, select it in the 
Hour of day field. 

The Step Details that you entered are displayed in the routing list at the bottom 
of the window. Note the following: 

 In the Stop Action column, a delta symbol (Δ) means the step is a non-
production step and no costing information is collected for it; a bullet symbol 
(•) means that completion of the step will mark the invoice ready for pickup.  

 The Date Stamp column has the completion category (if any) for the step. 
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 In the Auto Schedule column, O indicates the scheduled from order date 
and W indicates the wanted by date. 

 

9. To add the next step to the routing, click New Step and complete steps 6 through 
8 above. (You can add up to 30 steps to a routing.) 

Editing a routing 

You can edit a routing. If the routing was already assigned to a job, the changed routing 
information for that job is not affected; your changes apply only to future jobs that use the 
routing.  

1. On the Routing Setup tab in the Tracker Manager window, select a step in the 
bottom pane of the tab and make your changes. 

2. To add a new step to a routing, select any step in the routing and click New 
Step. The new step is automatically added as the last step in the routing. Define 
the step as described in steps 6 though 8 above. 

3. To re-order the steps in the routing, drag them to a different location in the list of 
steps.  

4. To delete a step from the routing, select the step in the routing list, click Delete, 
and click Yes to confirm the deletion.  

Duplicating routings and steps 

Many of the job routings in your facility are probably quite similar with minor variations. To 
save time when creating routings, you can duplicate both routings and routing steps.  

To duplicate a routing 

1. On the Routing Setup tab in the Tracker Manager window, select any step in the 
routing that you want to duplicate. 

2. Click Duplicate Routing. An exact copy of the routing is added to the bottom of 
your routing list.  

3. Give the copied routing a unique name and make any necessary changes to the 
routing and its steps. 
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To duplicate a step 

1. Select the step that you want to copy and click Duplicate Step. The copy is 
added to the routing list after the step that you copied.  

2. Make any necessary changes to the copy. 

3. If necessary, drag the step to a new place in the same routing or drag it to 
another routing. 

Deleting a routing 

If you no longer need a routing, you can delete it. 

1. On the Routing Setup tab in the Tracker Manager window, select the first line of 
the routing that you want to delete and click Delete. 

2. Click Yes to confirm the deletion.  

Checking the Status of Invoices  

After an invoice is in production you can check its status. 

1. Open the invoice and select Invoice > Tracker Status. The Tracker Status 
window opens.  

The top part of the window shows the estimated versus actual times for all items 
in the invoice, as well as the Current status of the invoice: Active, Not Started, 
or Completed. 

Tip  You can also release an invoice to production from the Tracker Status 
window. See page 67. 

The History tab lists the status of all the items in the job. The Routings tab 
shows the status of the routing steps. (This applies only if you use routings.) 
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2. Review the information on the History tab.  

Icons in the Status column provide visual cues: 

 Notes were entered for the item. 

 The item was started and is active in the production process. 

 The item was cancelled during the production process. 

 The item was processed and is complete. 

 An exception code was entered for the item.  

 The item was paused during the production process. 

In addition to the icons, the following information is available: 

Column  Description 

Item A reference number for the job in the format 0000/0/0 where the first part is 
the invoice number, the second is the job number, and the last is the step 
in the process. 

Description The description of the job. 

Location The place where the item is being (or was) completed. 

Facility The name of the facility where production is taking place. 

Employee The name of the employee who is working on the item. 

Estimated The time estimated for the completion of the item.  

Actual The actual time it took to complete the item in the production process. 

Date Complete The date and time the item was completed. 

Costing If costing was defined, the actual cost based on time and materials.  

  

Click to 
update 

display of 
items. 
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3. Do any of the following on the History tab: 

 Sort the list of items differently by clicking a column header. 

 Update the information in the window by clicking Refresh. 

 Double-click an item to open the Tracker Details window where you can see 
more information about estimated versus actual times and costs (if you have 
permission to do so) and enter notes about the item. For more information 
about the Tracker Details window, see page 76. 

4. If you use routings, click the Routings tab. 

Note  If the routing has schedule settings based on ordered date or wanted by 
date, a preliminary or estimated run date is assigned to the job. (You 
can edit this in the tracker production window. See page 68.) 

 

The Routings tab includes the following information: 

Column  Description 

Complete An x indicates the step is complete.  

Item A reference number for the job in the format 0000/0/0 where the first part is 
the invoice number, the second is the job number, and the last is the step 
in the process. 

Location The place where the item is being (or was) completed. 

Facility The name of the facility where production is taking place. 

Est. Run Date The calculated run date based on the ordered date or the wanted by date 
schedule settings on the Routing Setup tab of the Tracker Manager 
window (see page 38).  
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Reviewing Collected Costing Information 

Once work is finished on a job, you can open the invoice and review the costing 
information that Tracker collected and see how it compares to your estimated costs. 

1. Open an invoice. 

 

2. Click Costing on the toolbar of the Invoice window. The Costing window opens. 

 

Orange 
identifies 

data 
collected by 

Tracker. 
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3. The actual costs collected by PrintSmith Tracker are displayed in orange. 
Compare the estimated to actual costs and examine your profit margins: 

 Actual Cost – Actual cost of the job (labor and material). 

 Difference – The difference (as an amount and percentage) between 
estimated and actual costs. (A negative number means the estimated costs 
were higher than the actual costs.) 

 Price – The amount the customer is being charged. 

 Margin – The profit or loss (as an amount and percentage) based on the 
actual costs and the price.  
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Running Production and Employee Reports 

Production reports provide information about completed dates, estimated versus actual 
costs, and missed targets. The Employee report provides information about billing hours.  

To run a production report 

1. Select Admin > Tracker Manager. 

2. Click the Tools tab. 

3. Click Production Reports. The Production Tracker Report window opens. 

 

4. In the Report Type field, select one of the following: 

Completed Date For a report that shows scheduled versus completed dates, 
estimated versus actual times, and exception codes. 

Estimate vs. Actual For a report that shows completed dates, estimated versus 
actual costs and exception codes. 

Missed Target For a report that shows scheduled versus completed dates and 
exception codes. 

5. Under Date Range to View, select Last Week or select Date Range and enter a 
range. 

Click to 
update 
the 
report. 
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6. Click View. 

7. To update the information based on recent Tracker activity, click Refresh. 

8. To print the report, select File > Print. (You may want to print in landscape mode 
so all the columns fit.) 

To run an employee report 

The Employee report provides information about billable hours and includes completion 
dates, estimated versus actual times, estimated versus actual costs, and the percentage 
that was billable. 

1. Select Admin > Tracker Manager. 

2. Click the Tools tab. 

3. Click Employee Reports. The Employee Tracker Report window opens. Billing 
Hours is the only format available.  

 

4. Under Date Range to View, select Last Week or select Date Range and enter a 
range. 

5. Click View. 

6. To update the information based on recent Tracker activity, click Refresh. 

7. To print the report, select File > Print. (You may want to print in landscape mode 
so all the columns fit.) 
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Reviewing and Editing Time Cards 

You can review employee time cards at any time and edit them if necessary, for example, 
to correct a time.   

1. In Employee Manager (Admin > Employee Manager), click Edit time cards. 
The Employee Time Cards window opens. 

 

2. Under Employees, select an employee. Time card information for the selected 
employee is displayed. 

3. Use the tabs at the bottom of the window to select the pay period you want to 
review:  Active Period, Previous Period, All, or Specify Period.  If you select 
Specify Period, enter the number of the period in the Specify Period field. 
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4. To edit an entry: 

a. Either double-click the entry or select it and then click Change. The 
individual time record opens. 

 

b. If necessary, make changes in the In and Out, Billable Time, or Break 
Time fields. 

c. If the entry represents time off for which the employee was compensated (for 
example, a holiday), select the Paid time off check box. 

Note   Paid time off is not counted against production totals. 

d. Click Save to save your changes. 

5. To add a new time card entry for a single employee or multiple employees: 

a. In the Employee Time Cards window, click New.  A time card window opens 
for the selected employee. 

b. If you want this entry to apply to several employees, click + next to Show 
affected employees.   

 

Either click Select All to select all the employees or click the column to the 
left of the ID column to select individual employees. A bullet identifies a 
selected employee. (Click again to de-select the employee.) 
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c. Complete the Period, Clock In and Out, and Billable Time or Break Time 
fields. If you are entering time for a holiday, select the Paid time off check 
box. 

d. Click Add. The time card window closes and the time card entry is saved 
and added to the time card records for all selected employees. 

6. To delete time card entries: 

a. In the Employee Time Cards window, select an employee and then the time 
card entry you want to delete. 

b. Click Delete.   

Note   If a time card entry was made for multiple employees, deleting the entry 
for the selected employee does not delete it for the other employees. 

  

Click to select 
or de-select 

an employee. 

Click to select 
all employees. 
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Running Employee Time Reports 

You can run a variety reports to analyze the time employees have worked.  

1. In Employee Manager (Admin > Employee Manager), click Reports. The 
Employee Time Reports window opens. 

 

2. In the Format field, select  By Name, By SSN, By Period, By Week, By Month, 
or By Year. 

3. Under Range, select Period (and enter the range of periods) or select Date (and 
enter the date range). 

4. Under Detail, select Show full time card or Show totals only. 

5. To include all employees in the report, click Select All. To include particular 
employees in the report, in the list of employees, click the column to the left of 
the ID column. A bullet indicates the employee will be included in the report. (To 
remove an employee from the report, click the column again so the bullet is not 
displayed.) 

6. To see the report, click Preview.  The report opens in a preview window. 

7. Click Print to print the report or Close to return to the Employee Time Reports 
window. 

Note   The employees that you selected are remembered the next time you run the 
report.  

Click to include 
or exclude an 

employee. 

Click to 
include all 

employees. 
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Exporting Employee Time Information 

If you want to use the employee time information recorded in Tracker in a payroll system, 
you can export the information to a tab or comma-delimited text file.  

1. In Employee Manager (Admin > Employee Manager), click Exports. The 
Employee Time Exports window opens. 

 

2. in the Format field, select  By Name or By SSN. 

3. Under Range, select Period (and enter the range of pay periods) or select Date 
(and enter the date range). 

4. Under Options, 

a. If the first line of the export should be the field name, select the Include field 
name check box. 

b. Select Tab or Comma as the delimiter for fields in the export file. (The 
system into which you are importing the information may require a particular 
type of delimiter.) 

c. For Line End, select <cr> - (Mac) or <cr,lf> - (PC). 

5. To export all employees, click Select All under the list of employees. To export 
particular employees, click the column to the left of the ID column. A bullet 
indicates the employee will be exported. (To prevent an employee from being 
exported, click the column again to remove the bullet.) 
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6. To export all fields for an employee, click Select All under the list of fields. To 
export particular fields, click the column to the left of the field name.  A bullet 
indicates the field will be exported. (To prevent a field from being exported, click 
the column again to remove the bullet.) 

7. Click Export.  A Save As dialog opens.  

8. In the Save As dialog box, 

a. Leave the default name for the export file or enter a new name.   

b. Browse to the folder where you want to save the file. 

c. Click Save. The file is saved as a .txt file in the folder you specified. 

Clearing Tracker History 

PrintSmith Tracker collects a large amount of data. If you have a shortage of disk space, 
you may want to clear some of the historical data periodically. If, however, disk space is 
not an issue, EFI recommends that you not clear historical data unless you are sure you 
no longer need it. 

Note  When you clear Tracker history, the costing information is not removed from 
invoices. Only the details used to create the costing record are removed. 

1. Select Admin > Tracker Manager. 

2. Click the Tools tab. 

 

3. In the days old field, enter a number of days. 

4. To clear data older than the number of days you set, click Clear Tracker history 
for Documents more than. 

Note No data gets cleared, no matter how old it is, unless you click Clear 
Tracker history for Documents more than. 
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Overview 

This chapter describes how to use Tracker on the shop floor. The Tracker Console is the 
heart of PrintSmith Tracker – this is where you record data about the work you are 
performing.  

Before you can use the Tracker Console, you must clock in. Depending on your employee 
profile, you may then need to provide a PIN or swipe a card with your employee bar code 
before you can use the Tracker Console. 

Before you start using the Tracker Console, EFI recommends that you read the 
introductory information about the Tracker Console features so you understand the 
process of using it.  
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Clocking In and Out 

Before you can use the Tracker Console, you must clock in so your work is recorded. 
When you take breaks, you record the break (and then clock in at the end of the break). At 
the end of your shift, you clock out (unless you are automatically clocked out by the 
system.)   

1. In Employee Manager (Admin > Employee Manager), click Clock In/Out. A 
window that shows the current date and time opens. 

Tip  Managers can use this window to see who is clocked in or out, or on 
break. 

 

2. Select your name in the list at the bottom of the window. 
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3. Click Clock In, Clock Out, or On Break. (When you come back from break, click 
Clock In again.)   

4. If you are clocking in, and your employee profile requires you to scan your 
employee number, do so now. 

If your employee profile requires you to enter a PIN, either enter the PIN and 
click OK or click + to display a numerical touch pad (if your shop uses touch 
pads) and enter the PIN. 

Note If you enter the wrong PIN three times in a row, you cannot proceed. 
Contact your system administrator to obtain the correct PIN and try 
clocking in again. 

 

Opening the Tracker Console  

If your employee profile requires you to enter a PIN or to swipe a card with your employee 
bar code, you will need to do this before you can start to use the Tracker Console. 

If your employee profile has Auto show Tracker Console at clock in selected on the 
Personal tab (see page 24), the Tracker Console window opens automatically after you 
clock in. Otherwise, perform step 1 below. 

1. Select Admin > Tracker Console. The Tracker Console window opens. 

2. A list of employees is automatically displayed for the Employee name field. 
Select your name. (You must be clocked in before you can select your name. If 

necessary, click  to clock in.) 

Note To edit an employee profile, click . (You must have permission to 
work with employee profiles.) For information about employee profiles, 
see page 22. 

Click to display 
a numerical 
touch pad. 
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3. If you are not required to enter a PIN or to swipe a card, start using the Tracker 
Console. Step 4 does not apply to you. 

4. If your employee profile requires you to use a magnetic card with your employee 
bar code, swipe your card now. 

If your employee profile requires you to enter a PIN, either enter the PIN and 
click OK or click + to display a numerical touch pad (if your shop uses touch pad 
technology) and enter your PIN. 

Note If you enter the wrong PIN three times in a row, you cannot proceed. 
Contact your system administrator to obtain the correct PIN and try 
logging in again. 

Once you are logged in, the contents of the Active Items tab will be based on your 
employee profile – you will see the invoices, due dates, production parents, pricing 
methods, charge types, presses, and copiers that were set for you with production filters.  

  

Grayed out 
names mean 

the employees 
are not 

clocked in. 

Click to 
clock in. 
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Understanding the Active Items Tab 

The Active Items tab in the Tracker Console lists all active items and items to be released 
to production. This section provides an overview of this tab to orient you to its features; 
subsequent sections provide more details about how you use the Tracker Console in your 
daily work. 

 

Active item list 

The top pane of the Active Items tab shows all jobs and job items that are either in 
production or not yet released to production. 

 Items in black are released to production and on track.  

 Items in red are past due. 

 Items in blue are production parents (the steps just before yours). 

 Items that are struck through are on hold or not released to production. 

Active 
items 
list. 

Time 
bar. 

Your 
active 
item 
list. 

Click to 
update 
data. 
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Note What you see depends on your employee profile. For example, if the Any Past 
Due check box is not selected in your production filter, you will not see items 
displayed in red. Similarly, you may or may not see production parents. 

For each item, the following information is displayed: 

Column  Description 

Item A reference number for the job in the format 0000/0/0 where the first 
part is the invoice number, the second is the job or job charge, and 
the last is the step in the process. 

Description A description of the overall job or the step. 

Delivery Date The date the customer requested the job to be completed. 

Production Location The stage the item is in. This comes from the press, copier/digital, 
or charge definition.  

Run Date The scheduled run date based on routing definitions. 

Active Location The location where the item is running. (You select this location 
when you start work on an item.)  

Estimated The estimated time for completing the overall job or step.   

Priority The priority of the job. (This is set in the tracker production window; 
see “Releasing jobs to production” on page 68.) 

Machine The ID of the press or copier. (This comes from the press or 
copier/digital definition.)  

Account The number and name of the customer who ordered the job. 

You can do any of the following while reviewing the list of items: 

 Sort the list differently by clicking the header of the column by which you want the 
information sorted, for example, by Run Date or Active Location. 

 Update the production information by clicking Refresh in the lower left corner of 
the list. 

 Double-click an item to open the tracker production window where you can 
release a job to production, assign a routing to a job, or set a priority. For more 
information, see “Releasing jobs to production” on page 68. 

Current Station area 

The Current Station area shows the Facility and Station name (which are based on the 
computer where PrintSmith is running). The Location is the production location, and can 
be changed. When the job is started, the selected production location is displayed in 
Active Location column of the items list. 
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Barcode Input area 

If your shop uses bar code scanners, an invoice can be scanned at the beginning and end 
of a job, and Tracker data is recorded in the Barcode Input area. Employee bar codes 
can be printed as described on page 30 and then scanned as necessary.  

 

Buttons on Active Items tab 

 

The buttons on the Active Items tab let you record the various stages of a job, as well as 
look at associated documents (invoice, job ticket, cut diagram). Buttons are available only 
when they can be used. For example, Start is available only after a job is released to 
production and then unavailable after you click it to begin a job. In addition, some buttons 
change depending on what you are doing. 

The table that follows provides an overview of the buttons; details are provided in the 
procedures that follow. 

Button Click this to 

Start Begin timing a job or job item. 

Setup Done Indicate that the initial setup for a job or job item is completed. 

Washup Indicate that the printing of a job is complete and the press is being cleaned for the 
next job. (This button is available only for printing jobs that require washup.) 

Finish Up Indicate that a job is complete and the equipment is being prepared for the next 
job. 

Next Pass Start the next pass of a multi-pass job.  

Stop Record the end of the job (when all steps are complete).  

Cancel Interrupt a job and remove any recorded times.  
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Button Click this to 

Pause Suspend a job because you are not actively working on it. This stops the timer, but 
does not cancel the job, so that an accurate time is recorded for the job. 

Continue Resume a paused job so that the time continues to be recorded.  

Open Open the invoice for the job. 

Job Ticket Open the job ticket. 

Layout Open the cutting diagram. 

Time bar 

 

The time bar provides a graphic representation of the time a job takes. After you click 
Start, Tracker begins to record the time that it takes for setup steps, the main process, 
and finish up steps to occur. The time bar provides visual indicators of both estimated and 
actual time. A digital timer (see page 64) to the right of the time bar provides the 
corresponding numeric information. The machine name is displayed in the middle of the 
time bar. 

Tip You can open the Tracker Details window by double-clicking the time bar. For 
information about the Tracker Details window, see page 76. 

Colors in the time bar are used as follows: 

 Green indicates the estimated setup time for a job. 

 

 Blue indicates the main process and finish up/washup time for a job. 

 

 Yellow indicates that the job was paused or stopped.  
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Triangles in the time bar provide additional information: 

 A blue triangle at the top of the time bar indicates estimated setup time (when 
setup should be complete). For multi-pass jobs, the top blue triangle has a white 
line dividing it. In addition, text to the left of the time bar - Pass (n of n) - 
identifies the current pass out of the total number of passes for the entire job. 

 A blue triangle at the bottom of the time bar indicates the actual setup time 
(Setup Done was clicked). 

 A red triangle is displayed at the bottom of the time bar indicates that the main 
process was completed and the washup or finishing steps were started (Washup 
or Finish Up was clicked).   

 

Digital timer 

The digital timer to the right of the time bar shows estimated versus actual time. The 
actual time is 0:00 before you start a job. After you click Start, the timer begins running, 
and the time is incremented. If the job is paused or stopped, both the time bar and the 
actual timer stop. If the actual time exceeds the estimated time, the digital timer is 
displayed in red as shown below. 

 

For multi-pass jobs, the digital timer shows the estimated time for each pass; the actual 
time is set to 0 at the beginning of each pass. 

Your active item list 

The bottom pane of the Active Items tab lists only those items on which you are working.  
While you may be able to see (depending on your employee profile) production parents, 
jobs not yet released to production, or other jobs in the pane at the top of the Active Item 
tab, the bottom pane lets you focus on the jobs that you currently have in progress. 
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For each item, the following information is displayed: 

Column  Description 

Item A reference number for the job in the format 0000/0/0 where the first 
part is the invoice number, the second is the job or job charge, and 
the last is the step in the process. 

Description A description of the overall job or the step. 

Time/Qty The total estimated time for the job. 

Duration The actual amount of time the job has been in production. 

Who The name of the employee who is working on the production item. 

Facility The physical location/building where the item is in production. 

Station The computer where data is being collected for the item in 
production. 

Location The equivalent of Active Location in the active items list in the top 
pane. (This comes from the Location field under Current Station.)  

Machine The ID of the press or copier. (This comes from the press or 
copier/digital definition.)  

Account The number of the customer who ordered the job. 

You can do any of the following while reviewing the list of items: 

 Sort the list differently by clicking the header of the column by which you want the 
information, for example, by Location. 

 Update the production information by clicking Refresh in the lower left corner of 
the list. The numbers in parentheses (# of #) next to the Refresh button show 
how many active items you are working on out of the total number of active items 
in production. 

 Double-click an item to open the Tracker Details window where you can see 
more information about estimated versus actual times and costs (if you have 
permission to do so) and enter notes about the item. For more information about 
the Tracker Details window, see page 76. 
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Setting Preferences for the Active Items Tab 

Although your employee profile controls what you see on the Active Items tab in the 
Tracker Console, preferences let you customize some additional aspects of what is 
displayed. For example, you can hide items that were not released to production or show 
selected stations only. 

1. In the Tracker Console window, click Preference. 

 

2. Under Start new items here, select the default facility and station for new items 
to start. (You can always override these.)  

3. Under Show These Pending Items, select the Hide items not released to 
production check box so that only items that are released to production are 
listed; select the Only show employee’s Production Parents check box to list 
just the production parents that apply to you. 

4. Under Show these active items: 

a. Select the Selected employee only check box to list just the items that 
apply to you. 

b. Select the Show all Facilities check box to list the items in all the facilities. 

c. Select the Show all Stations check box to list the items at all stations or 
leave the check box cleared and click to the left of the stations you want to 
include. 
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5. Under Font settings, change the size of the font for the Pending List and/or 
Active List. Large fonts are recommended if you use touch screen technology.  

6. If you change the font size, close and re-open the Tracker Console for the font 
change to take effect.  

Releasing Jobs to Production 

Before employees can work on jobs and record the time they are spending on them, the 
jobs must be released to production. Typically, someone in a supervisory role releases 
jobs to production, but you can allow any employee to release jobs to production by 
selecting the Allow to modify production settings check box in the employee’s profile 
(see “Entering personal information for an employee” on page 24).  

Note Jobs that are not released to production are listed in the Tracker Console with a 
strike through. (The employee profile controls whether an employee sees 
unreleased jobs in the Tracker Console.) 

You can release jobs to production from two places in PrintSmith: 

 From the Tracker Status window.  

 From the tracker production window. In this case you can assign a priority to the 
job in addition to releasing it to production. If you use routings, you can also 
assign a routing to the job.  

Releasing jobs to production from Tracker Status window 

If you just want to release all the jobs in an invoice to production, use the Tracker Status 
window. 

1. When an invoice is open, select Invoice > Tracker Status. The Tracker Status 
window opens. 

 

2. Select the Release to production check box and close the window. 

3. Click File in the Invoice window. All the jobs in the invoice are now released to 
production. 
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Releasing jobs to production from tracker production window 

If you want to assign a priority to a job or assign a routing to it (if your shop uses routings) 
in addition to releasing the job to production, use the tracker production window. 

1. Do one of the following: 

 In the Pending Documents window, select an invoice and click Tracker. 

 When a job is open, click Tracker Production under Commands in the left 
pane of the Job window.  

 On the Active Items tab in the Tracker Console window, double-click the 
item you want to release. (Items that are not released are struck through.)  

A window opens with the number of the invoice and job displayed in its title bar. 
This is known as the tracker production window. 

Note If you selected an invoice with multiple jobs in the Pending documents 
window, a tracker production window opens for each job in the invoice. 

 

2. Select the Release to production check box. 

3. In the Priority field, select the kind of priority the job should receive, for example, 
Normal or Rush. (Priorities are defined in the Production Priority table and are 
specific to your shop.) 

4. If you use routings at your shop, add a routing to the job: 

a. In the Routing field, select the routing you want to assign. 
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Note Any changes you make to a routing affect only the current job; the 
original routing definition remains the same. 

b. To change the facility or location for a step, select the step and then make 
different selections in the Facility and/or Location fields. 

c. To add a step to the routing, click New step. 

d. If necessary change the date in the Run Date field for a step or its time in 
the Run Time field. Dates can be in the format mmddyy or mmddyyy. If you  
just enter a date as mmdd, the current year is added automatically. Times 
can be in the format hhmm followed by AM or PM. If you enter a number 7 
through 11, the system adds AM; if you enter 12 through 6, the system adds 
PM. 

e. To move the run date ahead or back one day at a time, select one or more 
steps and click + or – to the right of Selection, bump. (If you select all the 
steps, you can bump the entire routing.) 

f. To remove a step, select it and click Remove or click the X column. If you 
click Remove, the step is no longer displayed; if you click the X column, the 
step is removed from the routing but is still displayed. 

g. To order the steps by their run date, click Sort by run date. 

h. To re-order the steps, drag them. 

i. To remove the routing altogether, click Remove Route and then click Yes to 
confirm. 

j. To include a job routing ticket and a sheet of location bar codes when you 
print the job ticket, select the Attach to job ticket check box. 

Note If a completion category is associated with a step in a routing, the step 
is automatically stamped with the date and time when it is completed (in 
the Stop Tracker Step window; see page 72). Otherwise, you can enter 
this information manually. 

5. To print a list of all the charges for the job, together with bar codes (if your shop 
uses bar codes), click Print (or select File > Print). Your changes are saved 
automatically when you click Print. 

6. To save your changes, click File. 

Recording Time Spent on a Job 

After a job is released to production, you can start work on it and record your time. 
Depending on your employee profile, you may see production parent items (items in the 
step before yours) on the Active Items tab to let you know that a job is coming your way. 
For example, if you work in the bindery, items in the press location would typically be your 
production parents.  
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Production parent items are displayed in blue on the Active Items tab. After a production 
parent item is completed in the step before yours, it is still displayed in blue, but the 
Active Location column indicates that the step is done, for example, Press (done).  

Tip Click Refresh frequently to make sure you are seeing the most current 
production information. 

General procedure 

This procedure assumes that you are already clocked in (page 57) and logged into the 
Tracker Console (page 58). 

Tip If your shop uses scanners, you can scan bar codes at the beginning and end of 
each process instead of clicking buttons on the screen. 

1. In the top pane of the Active Items tab in the Tracker Console window, select 
the item on which you want to work. 

2. To look at the invoice for the item, click Open; to look at the ticket, click Job 
Ticket; and/or to look at the cutting diagram, click Layout. (You can do this at 
any time.) 

3. Click Start. 

The item that you started is now listed in the bottom pane, and the timer starts 
running.  

Note If you try to start a job that you already started, a message asks if you 
want to restart the beginning timers. You cannot start the same active 
item more than once, but other employees can start the same item 
because several people may need to work on the same production 
process at the same time. In this case, information for all the employees 
is tracked and can be seen in the Tracker Status window. 

4. To see more details about an item, double-click the time bar or the item in the 
bottom pane. The Tracker Details window opens. For information about this 
window, see page 76. 

5. To change your mind about recording time spent on the item, click Cancel and 
then click Yes to confirm. The time that was recorded is discarded, and the item 
is listed just in the top pane again. 

6. If you need to stop recording the time temporarily, click Pause and then click 
Continue to resume. If you are pausing because you are going on break, record 
the break. For more information about pausing jobs and recording breaks, see 
page 71. 

7. If the job requires preparation (such as make-ready), click Setup Done after the 
preparations are done. For more information, see “Indicating setup is complete” 
on page 72. 

8. When the main process of a job is complete, but the job requires washup, click 
Washup. (This applies only to printing jobs.) If the job requires other finishing 
steps, click Finish Up. (These buttons are available only when applicable.) 
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After you click Washup or Finish Up, a red triangle at the bottom of the time bar 
indicates the start of the process. 

 

9. If a job requires multiple passes, click Next Pass at the end of the current pass 
to start timing the next pass. Then repeat steps 5 through 7 as necessary. (The 
Next Pass button replaces the Stop button until the last pass is complete.)  

The number of passes is displayed to the left of the time bar to let you know 
which pass of the total number of passes is currently being tracked. Each pass is 
recorded in the Tracker Details window (which you can open by double-clicking 
the time bar). For more information about the Tracker Details window, see page 
76. 

 

10. Once the entire job is complete, click Stop to indicate that all the processes for 
the job are done and that timing should stop. The Stop Tracker Step window 
opens. Complete this window as described on page 72. 

11. To check on completed items at any point, click the Completed Items tab. For 
more information, see page 79. 

12. When you are done for the day, remember to clock out so your hours are 
recorded accurately. 

Pausing and continuing processes 

If you are called away from your machine or process, you can click Pause to stop the 
time, but keep the data that was collected up to that point.  

Important If you are pausing because you are going on break (for example, lunch), be 
sure to record the break by clicking the blue icon to the right of the 
Employee Name field and then clicking On Break. When you return from 
the break, clock in again. 

 

When a job is paused, the time bar is displayed in yellow, and the timer stops.  

Click to record a 
break. 



EFI PrintSmith │ Tracker User Guide 

 

 
Page 72 

 

In addition, a yellow pause icon is displayed next to the item that you paused. 

 

When you are ready to start work on the paused item again, click Continue to resume 
timing. 

Indicating setup is complete 

After you start a job that requires preparation, the Setup Done button is available so that 
you can indicate that the preparation is finished. Although you do not have to record the 
setup time, it gives you a more accurate picture of how long the various production steps 
take.  

The estimated setup time is displayed in the time bar in green with a blue triangle at the 
top of the time bar. 

 

 

After you click Setup Done, a blue triangle is displayed at the bottom of the time bar to 
indicate the actual setup time. The setup time is also recorded in the Tracker Details 
window (which you can open by double-clicking the time bar). 

Completing the Stop Tracker Step window 

After you click Stop in the Tracker Console, the Stop Tracker Step window opens. In this 
window you can review the estimated versus actual time and material costs, adjust the 
actual times and costs (if you have permission to do so), select an exception code to 
explain a problem that occurred during the production process, mark the step complete in 
the routing (if you use routings), and record spoilage. 

The top part of the Stop Tracker Step window includes general information about the item 
you stopped, for example,  the item number and description, facility and station, and 
production location where the step was completed. 

Estimated setup time. 
Actual 
setup 
time. 



Tracking Your Work 

 

 
Page 73 

 

1. If you are using routings: 

a. Select the Mark step complete in routing list check box to indicate the 
step is done. (This information is then displayed in the tracker production 
window and on the Routings tab of the Tracker Status window.) The Next 
Location field shows the where the job is moving next.   

b. Select the Move to this Non-Production step check box to move the job to 
the next non-production location, for example, a holding place such as 
staged print or staged bindery.  
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2. If a problem occurred during production, select the reason for it in the Exception 
code field, for example, Ink problem or Bad plate. (These codes are defined in 
the Production Exception table and are unique to your shop. They help to 
account for discrepancies between estimated and actual times and costs.) 

3. If no costs should be calculated for the step, select the Treat as Non-
Production step, no cost check box. For example, steps that do not incur a cost 
might be Proof, Completed-drying, or Staged – Copying. When the Treat as 
Non-Production step, no cost check box is selected, all cost information in the 
Stop Tracker Step window is hidden. 

4. Review the estimated and actual times and costs. If you are not allowed to 
change cost-related information, you can just review the information, but you can 
still enter spoilage as described in step 6. 

Note  Only those employees with the Allowed to override costs check box 
selected on the Personal tab of the Employee window (see page 24) 
can change cost-related information in the Stop Tracker Step window.  

5. If you are allowed to override costs, do one of the following: 

 If you want to replace the information in the Actuals column with information 
from the Estimated column, click the icon between the two columns.  

 If you want to enter actual times manually, enter them in the Setup, Run 
time, and Washup fields in the Actuals column. 

 

6. To calculate and record spoilage: 

a. If you need help calculating the spoilage, under Spoilage Calculator, enter 
the number of sheets run for the job in the Start field and enter the number 
of good impressions that were produced in the End field. Click Tab and the 
difference is displayed as a negative number.   

Click to replace 
actual costing 
data with 
estimated costing 
data. 
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b. In the Spoilage field of the Actuals column, enter the spoilage. This clears 
the data in the Start, End, and Difference fields under Spoilage 
Calculator, and the Spoilage field shows the number you recorded. 

 

7. In the Notes field, review or enter any production comments. If you want the 
production notes included on the job ticket, select the Append notes to job 
tickets notes check box.  

8. Click OK. 

9. If a routing was assigned to the item, and this is not the last step in the routing, 
the job moves to the next production location. If a routing was assigned to the 
item, this is the last step of the routing, and the Mark INV ready for pickup 
check box was selected on the Routing Setup tab of the Tracker Manager 
window for the step, when you click OK in the Stop Tracker Step Window, a 
message asks you to confirm that the invoice should be marked complete. Click 
Yes to confirm. 

The finished item is now removed from the Active Items tab and is listed on the 
Completed Items tab of the Tracker Console (see page 79).  

Note When a step is finished, the on hand quantity for the stock (if you track inventory 
for it) is reduced by the number of sheets actually used (including spoilage). The 
committed quantity is reduced by the original amount committed. The actual 
quantity used may differ from the committed quantity if the actual spoilage differs 
from the estimated spoilage for the job.   

Enter spoilage 
here. 
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Viewing Tracker Details 

You can review the details of an active or completed item in the Tracker Details window. 
You can open this window from many places in PrintSmith Tracker. 

1. Do any of the following to open the Tracker Details window: 

 On the Active Items tab in the Tracker Console window, double-click the 
time bar or double-click an item in the bottom pane. 

 On the Completed Items tab in the Tracker Console window, double-click 
an item. 

 On the Active Items tab in the Tracker Manager window, double-click an 
item. 

 In the Tracker Status window, double-click an item. 
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2. Review the information in the window. The information that is displayed depends 
on the status of the item, your employee profile, and whether the job is a single 
or multi-pass job. The Status field indicates the state of the current item, for 
example, Active, Paused, or Completed. If the status is Completed, the 
Completed field shows the date and time the item was done. 

 

If a job requires multiple passes, the Actuals column is replaced by a Current 
Pass column and Previous Passes column. (This applies to active items only.) 
The Current Pass column displays the times for the pass now taking place. The 
Previous Passes column displays cumulative times for all the passes that were 
already done. For example, if a job requires three passes, and the job is on its 
third pass, the Current Pass column displays information for pass 3. The 
Previous Passes column displays combined times for passes 1 and 2. 

 

3. If you need to provide a reason for a problem in the production process, select it 
in the Exception code field. (These codes are defined in the Production 
Exceptions table, and are unique to your shop.) 
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4. If an item is paused, and your employee profile allows you to override costs, 
change the information in the Setup or Run time fields in the Actuals column if 
necessary. 

Note If your employee profile has Hide costing amounts selected on the 
Personal tab in the Employee window, the amounts in the Stock Cost 
and Labor Cost fields in the Estimated column are hidden and the 
amount in the Cost field in the Estimated and Actuals columns is 
hidden. 

 

5. In the Notes field, enter any comments about the production process. 

Items with notes have an exclamation mark next to them on the Active Items tab 
in the Tracker Console. For more information about the Active Items tab, see 
page 60.  

 

6. Click OK. 

  

Costs are hidden. 

Indicates a 
note exists. 
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Viewing Completed Items 

After you enter information about an item in the Stop Tracker Step window (see page 72), 
the item is removed from the Active Items tab and added to the Completed Items tab in 
chronological order.  

The Completed Items tab provides a convenient way to see information about jobs that 
were just finished. You can clear the information from this tab if you want. Otherwise, the 
Completed Items tab is cleared when you close the Tracker Console or exit from 
PrintSmith. 

 

You can do the following when looking at the Completed Items tab: 

 Completed items are shown in chronological order (by date completed). If you 
want to sort the items differently, click the header of the column by which you 
want to sort the information.  

 To see additional information about an item, double-click it to open the Tracker 
Details window. For example, you may want to review estimates versus actual (if 
you have permission to see this information) or enter a note. (A gray icon 
indicates that a note was already entered for an item.) For information about the 
Tracker Details window, see page 76. 

Note If you try to open the Tracker Details window for an item that is not 
assigned to you, a warning message is displayed. 

 Information on the Completed Items tab is cleared automatically when you close 
the Tracker Console or exit PrintSmith. (You are asked to confirm this.) If, 
however, you have a large volume of work, and the Completed Items tab has 
many items on it, click Clear to remove the items. (There is no confirmation step 
so be sure you have finished reviewing the completed items.) 

  

Click to 
clear all 

items. 

Indicates 
note was 

added. 
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